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DotNetNuke Professional Edition Trial 

This document provides a quick self-guided tour of the DotNetNuke Professional Edition. It will walk you 

through building a new web site including: 

 Adding a new page 

 Adding new modules to a page  

 Changing the look and feel of your site by applying “Skins” 

 Creating Security Roles 

 Creating User Accounts 

 Adding Workflows to ensure that your site is reviewed and approved before being published 

 Using the Open Document Library to share and collaborate on documents 

 Using the Commerce Module to sell products 

 Using the Mobile Preview and Device Detection/Redirection 

 Using the Social features to create Social Groups and Member Directory 

 

For a more in-depth information please download the latest DotNetNuke User Guide and Super User Guide which 

are available on our website at no charge. We also recommend that you follow us on Facebook, LinkedIn and 

Twitter where the community shares information and useful tips. 

Start by signing up for the free trial of DotNetNuke Professional Edition. Your DNN installation is created 

on cloud to offer you instant access to the development environment.  

 
 

You are automatically logged into your DNN installation. You will notice that a demo site with sample 

pages – Home, About Us, Our Services, and Contact Us - has been created for you. We encourage you to 

watch the Getting Started video for an overview of DotNetNuke.  

  

Professional Edition 

http://www.dotnetnuke.com/Resources/Manuals/tabid/1667/Default.aspx
http://www.dotnetnuke.com/Resources/Manuals/tabid/1667/Default.aspx
https://www.facebook.com/dotnetnuke
http://www.linkedin.com/company/207975/careers?trk=NUS_CMPY_FOL-job
https://twitter.com/DNNCorp
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You can go back to the getting started page anytime from Help menu. 

 

 
 

You will receive a welcome email from DotNetNuke with information about your Website Address, Host 

Login, and Password. You can login as host by logging out of your user account and clicking the Login link 

in the upper right corner to login as a host with the username and password provided to you in the 

welcome email. For this exercise you will first login as a SuperUser with your host user name and the 

password  
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When you first log in, you will see your DotNetNuke Professional Edition environment in the View mode 

with Edit Page button greyed out.  

 

You will also see the new Control Panel at the top of the screen: 

 

The Control Panel enables you to create and manage the website content displayed below. When you 

first log into DotNetNuke, you see a default portal page with content that has been pre-populated. On 

the Control Panel there are two key menus titled “Admin” and “Host”. The Admin and Host menus 

enable you to manage individual web portals as an Administrator or multiple portals as a Super User or 

“host”. The Control Panel also has additional menus for commonly used tasks such as adding/copying a 

page, adding/reusing a module, uploading a file, or previewing a mobile site. In this demonstration we 

will show you how to create individual pages and manage an individual web portal both as an 

Administrator and as a Standard User. We will show you how to use the Host Tab to install new 

applications. We will also show you the Mobile and Social features of DotNetNuke. For more 

information about Host functionality please download the DotNetNuke SuperUser Manual.  

 

The Control Panel 

The Control Panel is the main interface for managing site pages, adding modules to pages, performing 

common administration tasks, and installing additional modules. Depending on your assigned role and 

associated access rights, different tools would be available.  

The Control Panel contains various sections which can be accessed by users with different roles. 

http://www.dotnetnuke.com/Resources/Manuals.aspx
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The Edit Page menu gives user the ability to quickly switch between Edit Page mode, View Page mode, 

and View Layout mode. It also provides quick access to common page tasks such as Page Settings, Page 

Appearance, Mobile Preview, Page Permissions, Export Page, and Delete Page.   

 

 
o Edit This Page Enables you to add, delete and change content. It provides you with access to the 

“Actions Menu” for all the modules on that page. Actions menu allows you to edit content, move 
module and control administrative settings for the modules. 

o View Mode is enabled by selecting Close Edit Mode and it hides all module editing tools and 
page pane layout. Select this option to see how the page will look to your site visitors.  

o View in Layout Mode displays the page pane layout with the module content hidden. Select this 
option to view the layout of a page. You can move modules to different areas/panes on the page. 

Add a Page 

You will notice that some sample pages in a demo site called “Awesome Cycles” have been created for 

you.  During this demonstration we’ll add a new page for promotional offers. Add a page to your online 

demo portal as follows: 

1. Select the Add New Page button in the Pages menu section of the Control Panel at the top of the screen 

   

2. At Page Details, enter the following settings:  
a. In the Page Name text box, enter the name “Promotions”. If you choose to display this new page 

in the menu, this will be the name which appears in the menu.  
b. In the Page Title text box, enter “Promotions”. This is the page name that will be displayed on 

the tab in a visitor’s browser when they visit this page.  



 

6 

 
Online Demo Script 

c. In the Description text box, enter “This is the Awesome Cycles Promotions Page” or other short, 
descriptive sentence summarizing the page content.  

d. You can enter relevant keywords for search engines in the Keywords text box. 
e. At Parent Page, select < None Specified > to set this as a parent page in the menu. If you wanted 

to make this page a child of another page, you would select a [Page Name] to set this 
relationship.  

 

f. For Permissions tab, set the view and editing permissions for this page for one or more roles. To 
make the page publicly accessible, check the View column for All Users. You can choose to 
provide various user classes with differing rights from viewing the page to adding content, 
copying or deleting the page, or managing the page settings.  Because we are using the 
Professional Edition we see an extensive list of security permissions. In the Community version of 
the product only “View and “Edit” permissions exist. For a more extensive overview of 
DotNetNuke’s granular permission capability please attend one of our Professional Edition 
Webinars. 

 

 

http://www.dotnetnuke.com/Intro/Webinars/tabid/1270/Default.aspx
http://www.dotnetnuke.com/Intro/Webinars/tabid/1270/Default.aspx
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3. Click the Add Page button at the bottom left of your screen.    
 

4. Now you see that we have added a new page called “Promotions” and that the page has some default 
content. By default DotNetNuke adds one instance of the HTML Pro module to the page. The HTML 
module is the most commonly used module and lets you add HTML content onto the page.  Let’s edit the 
content in that module. 

 

Edit the Module Content 
1. Click the Edit Page button to switch from View Page Mode to Edit Page Mode. 

 

 
 

 

 

 

 

 

2. Select Edit Content from within the Actions menu on the HTML Pro module to edit the content of your 

new module.   

 

 

 

3. You will be presented with a rich text editor. In the text box type “Get a 10% discount on all bikes.” using 
the available font formatting buttons. The new HTML Pro text editor auto saves the contents. 
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DotNetNuke Professional edition ensures that you never lose your work by auto saving the content as 

highlighted below. 

 

4. Click the Save button at the bottom of the page to publish your new page.    
5. Now change the Title of the module. Go back to the Options button in Actions menu and select 

“Settings”. 
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6. Change the title to “Promo”. 

 

7. Click the Update button.   

 

 

Your page should now appear like this: 

 

Install a Module 

The next thing we will do is add an Announcements module on the home page. We will use the 

“Announcements Module” that came pre-packaged with the DotNetNuke Professional Edition. In order 

to use this module we will have to first install it. To install this module you will: 
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1. Select Extensions from the Host menu in the Control Panel. 

 

2. Select Available Extensions and expand the Modules section of the page.  
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3. Install the Announcements module. 

 

4. Click Next button.

 
5. Select Accept License and click Next. 
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6. Click Return or Close the installation window. 

7. Now you can return to your Home page to install the new module on your page. 

Add a New Module 

Open the Promotions page and now let’s add some more interesting content. Let’s add an  

announcement section on the Promotions page. 

1. Select Modules   Add New Module. This will bring all the available modules 

 
2. Scroll to Announcements module and drag & drop it to the desired pane. 
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3. The Announcements Module will let you add a list of announcements to the page with a title, text, and a 

“read more” link. Go to Settings and update the Module Title to “Zany Announcements”. 

 

 

4. Click on Update  
5. Now we will add an announcement to the home page.  

Click on Actions menu Edit menu and select Add New Announcement 
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6. Enter the Title and Description. Click Update to save the announcement.

 
 

7. The Announcements module gives you the option to edit an announcement by selecting the edit menu 

on the top left corner of an announcement. The Announcements module also gives the author and admin 

the option to filter and view announcements by Current/Expired/Future/All categories. 
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Add a New Skin 

A skin is a design template used to change the look and feel of your DNN web site.  Now we’ll add a new 

Skin through Extensions > More Extensions.  

1. Go to Host > Extensions 

 
2. Select the More Extensions Tab  

 
 

3. Search for a New Skin by choosing: 

a. Type: Skin 
b. Search: Freestyle 

 

 
 

This Freestyle Skin is available free of charge through the DotNetNuke Extensions Forge. The Extensions Forge 

is the official repository of Open Source extensions for DotNetNuke.  
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4. Next deploy the Freestyle Skin. 

 
 

5. Next Deploy and Install the new Extension so that you can use it on your site. 

 



 

17 

 
Online Demo Script 

 
 

 

 

6. Allow the files to be installed by selecting the checkbox to ignore file restrictions. 

 
 

7. Click Next and Accept License 
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Change the Skin 

You can change the look and feel of a page or your entire site by changing the skin. Let’s select a new 

skin for our promotions page. “Skins” are modules that determine the look and feel of your website. 

Changing your website skin can change its color, graphics, and menu properties.  

To set the default skin applied to your promotions page:  

1. Navigate to Edit Page > Page Appearance 
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2. Select Page skin Freestyle – DNNFreestyle1Column and click Update 
 

 

You will notice the style of the page has now changed. If you click on one of the other tabs like “About 

Us” you will notice that the styling has not changed. This is because you have now added the new skin to 

your Promotions Page. 
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Move Content on the Page 

1. Now lets move the “Promo” module to the bottom pane. We’ll do this by selecting the View in 

Layout Mode from the Edit Page section in the upper right corner of the screen. 

 
2. Hover the mouse over the Move icon in the Actions menu of Promo module and slect To Bottom 

Pane to move the module into the bottom pane.  

 

3. Now switch back to “View” mode by unchecking the View in Layout Mode and you will see that the 

“Promo” module is now in the bottom pane of the page. 
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Add an Image to the Page 

1. Add a new HTML Pro module to the TopPane by selecting Add New Module from the Modules menu, 

selecting the HTML Pro module, and dragging & dropping it to the TopPane. 

 

 
2. Select Edit Content in the Actions menu for the new HTML Pro module  
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3. Now use the Image Manager to add the home banner image by selecting Insert Media  Image Manager 

 

4. Select the “homeBanner.png” image from the Images folder. 
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5. Select Insert  and then Save  

  

6. Finally remove the title on the new HTML Pro module. Select Settings from the Options menu in the 

Actions menu 

 

 

7. Erase the Module Title and choose  

 

 

8. Select Close Edit Mode by clicking   . Your page should now look like this: 
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Add a Security Role 

The Security Roles page enables Administrators to create and manage security roles. Security Roles 

control which users can access and manage site pages and modules. The following basic tasks can be 

performed on the Security Role pages: 

 Add new roles 

 Edit and delete existing roles 

 Manage the users assigned to each roles  

 

1. Navigate to Admin > Security Roles 

2. Click  

3. In the Basic Settings section complete the following fields:  

a. In the Role Name text box, enter the name “Content Editor”.  

b. In the Description text box, enter “Limited access”.  

 

4. Click the  button. 
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Add an User Account 

Administrators can manage the account details of all registered users from the User Accounts page. The 

following tasks can be performed under User Accounts: 

 Add a new user account  

 Edit an existing user account  

 Authorize or unauthorize user accounts  

 Manage security role access to user accounts  

 Delete a user account 

 Delete all unauthorized user accounts 

 
1. Navigate to Admin > User Accounts  

 

 

2. Select  This takes you to the Add New User page.   
3. In the User Name text box, enter a user name. The users email address is a common choice for this field, 

although any user name can be entered. The user name cannot be changed.  
4. In the First Name text box, enter the person's first name.  
5. In the Last Name text box, enter the person's last name.   
6. In the Display Name text box, enter the name to be displayed to others on the portal.  Note: This field 

may not be displayed. 
7. In the Email Address text box, enter a valid email address.  

8. At Authorize, check  the check box to authorize the user to access the portal.  

9. At Notify, check  the check box to send a notification email to the user's email address. This is the 
default setting.  

10. At Random Password,  

 Check  the check box to generate a random password. If this option is selected, skip to Step 
12.  

 Uncheck  the check box to create your own password. This is the default setting. 
11. In the Password text box, enter a password.  
12. In the Confirm Password text box, re-enter the same password.  

13. Click  . The user will now be added to the User Accounts list. 
14. If you created a password for this user, the user can now access the account using their username and 

password without the need to access system generated email that’s sent to new users. 
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Manage a User Account – by Administrator 

Administrators can add a user to a role to give the user the permissions given to the role. 

1. Navigate to Admin > User Accounts  
2. Find the required user account by using a filter or by searching.  

3. Click the Manage Roles  button beside the required user account. The details of the security roles 
this user currently belongs to are listed on this page.  

4. Within Security Role, select the role this user is to be added to. Select the “Content Editor” role for this 
user.  
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5. OPTIONAL. At Effective Date, click the  Calendar link and select the first date the user can access this 
role. Where no date is selected access will be immediately granted.  

6. OPTIONAL. At Expiry Date click the  Calendar link and select the last date the user can access this role. 
Where no date is selected access will not expire.  

7. At Send Notification?, select from the following options:  

 Check  the check box to send a notification email to the user informing them of their new role 
access. This is the default setting.  

 Uncheck  the check box to add the user to the role without notifying them. 

8. Click the button. 
9. Click Close. 

Using Workflows 

Workflows are a feature of both the Professional and Enterprise Editions of DotNetNuke. They enable 

you to define which user (or which user role) is able to edit specific content and then which user (or user 

role) must review and approve the content before it can be published. The Professional and Enterprise 

Editions ship with three basic workflows that you can use immediately. You may also create your own 

workflows with as many states and checks as you like.  

1. Select the Promotions Page 
2. Click Edit This Page to get back to the edit mode. Edit the “Promo” module settings by selecting Settings 

from the Options within Actions menu. 

 

3. Select the Permissions tab 

 
4. First we’ll give the “Content Editor” role the ability to make changes to the content in this module by 

checking “Add” and “Delete”. 
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5. Next we will assign a Workflow to this module. Select the HTML Modules Setting tab. In the middle you 
will see the Workflow section. Workflows enable you to decide who can edit content and who needs to 
review and approve it before it can be published. Workflows are available in both the Professional and 
Enterprise Editions. Select the “Content Approval” Workflow and then select Update. 

 

 

6. Now we’ll take a look at how this Workflow helps us to manage our content.  First logout of your 
SuperUser account by selecting logout in the upper right corner of the screen.  
 

 
Next login using the user account name that you created earlier by entering the user name and the 
password that you input when creating the user account 
 

7. You should now be logged in with your new account which is a member of the “Content Editor” role. 
Select the Promotions page. This user (and role) has permission to edit the content in the Promo Module. 
Select the Edit This Page button from the Edit Page menu on top right corner.  Edit the Promo module by 
selecting Edit Content from the Edit menu under Actions menu. (You will also notice that the Options 
menu contains fewer options because this user has limited access to make changes) 

 

8. Now change the text so that you offer customers a 25% discount. 

 

9. Scroll down and choose to “Publish Changes”. 

 

10. Select Save. 
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11. Add a comment and click on Add Comment. 

 

12. Logout of this account. You can see that no change was made to the published web site. It still reads “Get 
a 10% discount on all Bikes.” 

13. Now log back into your host account. Your host account has the ability to approve the change that was 
just submitted. Once you select the Edit Page, you will notice that the change is visible since you are 
logged in as SuperUser (Host). You can now approve or reject the change from within the Actions menu. 
Let’s approve the change. 

 
14. Add a comment. 
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15. You will see that the change has now been approved and published to the external Web Site. 

Version Tracking and Version Compare 

Rich HTML Pro Text Editor in DotNetNuke Professional Edition provides rich content editing tools 

including image management, spell checking and document versioning, version comparison, auto save 

and recover. 

1.    To review the version history, a user can go back to Edit Content under Edit menu within Action menu for 

a module  

 
2. Select the Version Tracking tab to see the full list of the all the versions by date, user, and state.  The 

Professional Edition offers you the functionality of both Version Tracking and Roll back. A user can roll 

back to a specific version by clicking on the Rollback icon. 

 

3. Select any two versions and choose  to compare those versions. The differences are 

highlighted and color coded. Users can compare in Design mode or HTML mode. 
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Document Management 

We will now add a new page to our site where we can upload and share documents with the Awesome 

Cycles Team. The DotNetNuke Professional Edition offers an advanced yet easy to use document 

management capability.  

1. Add a new page called Cycle Docs (for instructions about adding pages see Add A Page above) 

2. Add the Document Library Module to the page  (for instruction about adding modules see Add a Module 

above) 
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3. Right click on CachePages and select add sub-folder called CycleDocs: 

 

 

4. You can then select the Security Settings tab and select which User Roles can access this folder. 
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5. Click Update button  

 

6. Now you can upload documents from your computer by right-clicking on the CycleDocs folder that you 

created. Select a document to upload by clicking add document(s).  

 
7. You can define an expiration date for you document 
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8. The system shows you who uploaded a file and when.  

 

9. The system stores previous document versions and lets you roll back to previous versions. You can even 

set notifications so you will be alerted any time a document is changed: 

10. The Document Management feature also provides you with useful statistics about how your documents 

are used; including how many times a document has been downloaded. Click tools icon and then 

select Statistics and by Document. 

 
11. You can view detailed statistics for each document 

 

12. You can also select Moderate if you would like your documents reviewed and approved before they can 

be published. 

 

13. The Document Management feature gives you a simple way to consolidate all of your documents online 

for sharing with customers, partners, co-workers or others. The Document Management feature makes 

collaboration simple. 
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Commerce 

Commerce module will allow you to sell products from your site. The Commerce Module is lightweight, 
yet extremely powerful and allows you to process payments and sell a small set of products and 
services. (There are other ecommerce solutions that are designed to handle larger and more extensive 
product catalogs.) 

1. Create a Store page for the Awesome Cycles Site 
2. Add the Commerce Module to the page 

 

 

 
3. Manage store settings by opening the Control Panel from Edit menu within Actions menu 
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4. Go to the Products tab and then Create Product 

 

5. Add a new product 
a. Name: Unicycle 
b. SKU:  UNI123 
c. Price: $199 
d. Active:  
e. Visible:  
f. Description = A beautiful unicycle 
g. Click Save 

 

The other tabs enable you to manage orders and customers, create discounts, calculate tax rates and 
much more.  
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6. Click Close Edit Mode to go back to View mode. Go back to Store page. You will now see you new product 
listed for sale. 

 

 

 
7. Click Buy Now and the Commerce module will lead you through the payment process. (In order to 

actually collect payment you will first need to configure the Commerce module with your merchant 
account information.  
 
 

 
 
For instructions on using and configuring the Commerce module, please refer to the DotNetNuke 
User Manual 

  

http://www.dotnetnuke.com/Resources/Manuals.aspx
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Mobile 

DotNetNuke allows users to render websites across a wide array of devices – smartphones, tablets, and 
computers etc. by detecting device type and redirecting users to different pages or different websites. It 
also allows you to preview how the content will look on thousands of mobile devices. The DotNetNuke 
Professional Edition includes the Premium mobile device detection database which provides device 
attributes for thousands of devices and is updated weekly.  The DotNetNuke Professional Edition 
enables administrators to manage administrative tasks centrally across multiple web sites including 
mobile sites. 

 
Adding a Mobile site: 
1. You can create a mobile web site from the Site Management within Host menu in the Control Panel.  

 

2. Choose Add New Site 

 
 

3. Enter Site Alias – enter your main site alias and add the suffix “/m” to create a mobile site alias. Enter 
Title “Mobile Site” for the mobile site and choose Create Site. 
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4. Once the site is created, edit the site by selecting Edit option via Site Management 
 

 

5. Go to Basic Settings  Appearance and for Site Skin select Host: “DarkKnightMobile – home” to assign a 
mobile skin to the site and click Update. 
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6. You can utilize the content sharing and user sharing features available in the DotNetNuke Professional 
Edition to ensure that users can login and access content on either of the websites. This also provides 
versatile and efficient content creation option and at the same time ensures consistency of content and 
layout. 
 

a. Create a Promo page in the mobile site. Cross-site module sharing leverages the existing content 
across multiple web sites within a DNN installation. Select Add Existing Module to copy an 
existing module. 

 
 

b. Select Site as “Desktop”  Select Page as “Promotions"  Select a Module and drag and drop it 
to the required pane. You can also edit the content or modify settings to customize the copied 
module as per your requirements. 
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c. You can now go to your mobile phone’s browser and type the following in the address bar to 
access the new promo page that’s a part of the mobile site 
“http://dnn70mkt.cloudapp.net/mobile/Promo”. This page is optimized for mobile browsers and 
at the same time it shares the same desktop module content, ensuring consistency and ease of 
maintenance across multiple sites. 

 
7. Now you can direct all the traffic coming to your website from mobile devices to your mobile site.  

DotNetNuke also offers the option for dynamic site redirection based on the access device. Select Site 
Redirection Management from Advanced Options under Admin menu in the Control Panel 

 

 

 

8. There are two distinct site redirection options – Create a mobile website redirection directs all mobile 

users to the mobile website.  

 

 
9. Another option is to create a redirection using advanced options. Here you can specify a redirection 

destination – a page or a different site for redirection. You can also define how that redirection occurs for 

different kinds of devices such as a different redirect for mobile phone and a different redirect for tablets. 
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10. The most powerful and versatile site redirection option can be defined by choosing Select user device as 

Advanced. This allows the redirection based on capabilities such as iOS or android devices or browser 

versions etc.  

 
 

 

 

11. For a selected Capability, you can further specify the corresponding Matching Value from the list of 

options. For e.g., selecting the Capability of “Browser Name” provides a wide array of browser choices in 

the Matching Value for customized site redirection, based on the browser. In this case, we selected 

“Safari” as a growing number of our website traffic comes from Safari users. 
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It’s a good practice to redirect all your mobile traffic to your mobile site for a more engaging user 

experience. You can now test your mobile site by typing the main site address in the safari browser. The 

device detection and redirection will automatically direct you to the mobile site.  

Mobile Preview 

Mobile preview feature of DotNetNuke offers a versatile option for you right from your desktop and 
development environment to preview how a page renders on any mobile device or tablet. You can make 
any changes on the page and readily review it from the same environment without the need for multiple 
mobile devices or tablets. 

 

1. Mouse over the Edit Page menu in the control panel and choose the Mobile Preview  

 
2. You can select from a number of devices and the page will be rendered formatted for the specific device.  

This empowers the site developers to test a wide array of mobile devices – smartphones, tablets, 
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eReaders etc. – from within the same development environment. You can also select to choose portrait or 
landscape mode. 
 

 
3. The default skin in DotNetNuke loads in a similar way across different devices, as such the underlying look 

and feel does not differ across different devices.  

 

 

For detailed instructions about using the Mobile functionality please refer to the DotNetNuke User 

Manual. 

 

Social  

DotNetNuke enables you to create social intranet sites for internal, employee collaboration or external 

online communities for customers and prospects.  The following social features are available in all 

DotNetNuke editions: 

 Activity Feed - Interactive activity feed lets community members interact in a manner similar to the way 

they do on Facebook, Twitter, and LinkedIn. 

 User Relationships - Lets users “friend” and “follow” other users or groups. Allows users to approve or 

reject friend requests. 

 Social Groups - Users can create, join and share content on social interest groups. 

http://www.dotnetnuke.com/Resources/Manuals.aspx
http://www.dotnetnuke.com/Resources/Manuals.aspx
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 Member Directory - Users can find and connect with other users on the site. 

 Message Center – A central place for users to send and receive messages from other users and groups. 

 Interactive User Profiles - Site members can manage their personal profile with privacy controls, personal 

file storage, a user-focused activity feed and complete message center. 

 Social Authentication - Users can register and login to a DNN website using Facebook, Twitter, and 

Google+ credentials. 

 Social API - Enables you to write applications that access and control activity feeds, user relationships, 

social groups, user profiles, and notifications. 

In this example, we are going to develop a community section for the fans, customers, and users of our store 

Awesome Cycles.  

Create an Activity Feed 

Add a Journal module to create an activity feed. Journal module allows a user to put a status update. 

1. Add a new page titled Community and set the Skin to Host: Host: Gravity - Home. By default the pages 

are only visible to the administrator. 

 

2. Add a Journal module in the central pane to create an activity feed 

 
 

 

 

 

a. Module is currently only visible to the administrators 
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b. Go to Journal settings 

 
c. Increase the Maximum Characters per message from 250 to 500 words. Settings also has the 

option to enable or disable different types of Journal entries. 

 

d. Choose Update to save the settings. 
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3. Enter a welcome message.  

 
4. You can attach a photo or a file and also control the access to this post by setting Who will see this. 

 
5. You can also select the poster’s name to go to their profile page. 
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Updating Your Profile 

1. You can update your profile by logging in and selecting Visit My Profile. 

 

2. Select Edit Profile to go to the Manage Profile section.  

 

3. In Manage Profile, you can enter Name, Location, and Contact Details etc.   
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4. You can also upload a Photo to your profile page and enter Update 

 
 

5. The social features in DotNetNuke offer you the flexibility to set access level and privacy filter for each of 

these field 

 

 

Create Member Directory 

1. Member directory shows us the list of users or the members of our website and you can customize what that 

list displays for the user information. Add the Member Directory module in the right pane by selecting Add 

New Module from Modules menu in the Control Panel and dragging and dropping it to the right pane. 
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2. List of users or members of our website appears in the right pane. In this example, we only have a few 

members/users in the fictitious Awesome Cycles online community. 
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3. Member Directory Settings has options for Filters, Sorting, and Search on Member Directory based on various 

fields. 

 

Create a Social Group 

The social group feature allows users and administrators to create different groups for the community members 

based on users’ interests and preferences. This provides the community members an interactive and more 

relevant forum to connect, share, and discuss their topics of interest. The social groups can be public or private. In 

this particular example, we will create a social group to provide an interactive forum for the mountain bikers 

within the Awesome Cycles community. 

1. Add a new page titled Groups underneath the Community page. 

 



 

52 

 
Online Demo Script 

2. Add the Social Groups module in the content pane by selecting Add New Module from Modules menu in the 

Control Panel. 

 
3. You can either configure the module settings of the Social Groups or auto configure it by selecting 

   
It creates a couple of child pages and configures the settings for the Groups module here on the Groups page. 

4. Choose to create a new social group. 

5. Enter basic information such as Group Name, Description, Group Picture, and Accessibility. DotNetNuke gives 

you the option of setting proper checks and balances to make the site either Private or Public. For Public 

groups, there is an option to review and approve new members. 

Choose Create Group . 
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6. This takes us to the group activity page. Here one can enter posts as text, pictures, or files and additionally set 

privacy settings to restrict viewing rights. Click Share to post a message to the group. 

 
 

7. When a new user comes to the Social Groups page, they get an option to join the group by selecting the Join 

button. 

 
 

8. Members of the group can post on the wall to interact and collaborate with everyone. 

Messaging Center - Message and Notifications  

DotNetNuke has a user-friendly messaging center - a dynamic Message and Notifications feature visible 

on the top of the screen.  
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The Notifications icon is updated when a user gets a new friends request or a new post in their activity 

feed etc. The Message icon is updated when you receive a new message. Clicking on these icons takes 

you to the respective Message or Notifications screen. 

 

A member can send messages to other members or to groups.  DotNetNuke also provides an Activity 

feed for each user consisting of all the activities related to a user, his friends, and his groups. Users can 

also edit their profile and update their friend list. 

 

 

 
 

This provides the added security while the page is being created and setup. Page Permissions gives 

granular access control via Page Settings and here the community page is set to be visible to all users. 

You can also copy the permissions from the parent page to all the child pages. 
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DotNetNuke cohesively ties together the Social capability by integrating Interactive User Profiles, 

Member Directory, Social Authentication, User Relationships, Social groups, Message Center, and 

Activity Feed features to offer a full array of community building tools. It also provides Social API to 

provide versatility and granular control for developers. For detailed instructions about using the Social 

functionality please refer to the DotNetNuke User Manual. 

 

 

 

 

 

 

Thank you for trying the DotNetNuke Profession Edition Trial  

If you have not already attended one of our product demonstration webinars or deep dive webinars, we 
encourage you to visit DotNetNuke.com now and register for an upcoming event or view a prior 
webinar.  

DotNetNuke and DNN are registered trademarks of DotNetNuke Corporation. 
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